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XBee® Network Assistant User Guide

The XBee Network Assistant is a tool designed to inspect andmanage radio frequency (RF) networks
created by Digi XBee devices.
The application features include the following:

n Join and inspect any nearby XBee network to get detailed information about all the nodes it
contains.

n Update the configuration of all the nodes of the network, specific groups, or single devices
based on configuration profiles.

n Geo-locate your network devices or place them in custommaps and get information about the
connections between them.

n Export the network you are inspecting and import it later to continue working or work offline.

n Use automatic application updates to keep you up to date with the latest version of the tool.

n Access comprehensive online documentation directly from the application.
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Download and install XBee Network Assistant

This section provides instructions for downloading and installing the XBee Network Assistant tool.

Requirements 7
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Install USB drivers 8
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Requirements
This section describes the requirements to run the Network Assistant application.

Operating systems
XBee Network Assistant is compatible with the Windows Vista/7/8/10 (32-bit or 64-bit versions)
operating systems.

System requirements

Property Minimum Recommended

HDD space 300 MB 500 MB

RAM memory 2 GB 4 GB

CPU Dual-core processor Quad-core processor

Supported RF modules
n XBee SX (regular and PRO versions)

n XBee S1 (regular and PRO versions)

n XBee S2

n XBee S2B

n XBee S2C (regular and PRO versions)

n XBee 868LP

n XBee 868LP SX (regular and PRO versions)

n XBee3

Note XBee Network Assistant supports all of the above modules in all hardware variants, including
surface-mount technology (SMT), through-hole technology (THT) and XBee3 micro-mount technology
(MMT).
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Install XBee Network Assistant
Complete the following steps to download and install the XBee Network Assistant application:

1. Navigate to www.digi.com/xbeenetworkassistant.

2. Click XBee Network Assistant.

3. Under Utilities, click the Windows installer link.

4. When the file finishes downloading, run the executable file and follow the steps in the XBee
Network Assistant Setup Wizard.

Install USB drivers
The required USB drivers are automatically installed the first time you connect an XBee board to your
computer. If the board does not automatically install, use the following instructions to install the
board drivers manually:

1. Find the appropriate USB drivers on the Digi support site.

2. Select your operating system.

3. Download and run the executable file.

4. Follow the steps in the installation wizard.

http://www.digi.com/xbeenetworkassistant
https://www.digi.com/support/supporttype?type=drivers


RF concepts and terminology

This section contains concepts related to radio frequency modules and the XBee Network Assistant
application. Understanding these concepts will help you in working with XBee Network Assistant.

RF modules 10
Radio firmware 10
Configuration profile 10
Mesh networking 11
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RF modules
A radio frequency (RF) module is a small electronic circuit used to transmit and receive radio signals
on different frequencies. Digi produces a wide variety of RF modules to meet the requirements of
almost any wireless solution, such as long-range, low-cost, and low-power modules. The most popular
wireless products are the XBee RF modules.

XBee RF modules

XBee is the brand name of a family of RF modules produced by
Digi. They are modular products that make deploying wireless
technology easy and cost-effective. Digi has made multiple
protocols and RF features available in the XBee footprint, giving
you flexibility to choose the best technology for your needs.

XBee RF modules are available in three form factors: through-hole, surface-mount, andmicro-mount,
with various antenna options. Most modules are available in the through-hole form factor and share
the same footprint.

Radio firmware
Radio firmware is program code stored in a radio module's persistent memory that provides the
control program for the device. The main goal of the XBee Network Assistant application is the ability
to manage an already deployed network and to update the firmware and settings of all its devices
through the use of configuration profiles.
XBee Network Assistant takes the radio firmware to program from the configuration profile loaded in
the application. For more information about configuration profiles, see the, Configuration profile topic.

Configuration profile
A configuration profile is a snapshot of a specific radio firmware configuration. The profile is useful in a
production environment when you need to set the same radio firmware and parameters on multiple
radios. A configuration profile is an XPRO file containing the following elements:

n Radio firmware to be programmed in the device.

n Firmware settings to configure with their respective values.

n Other configurations andmetadata to identify the profile, such as the flash firmware policy,
profile description, and so on.

Before starting the programming process, you must load a configuration profile for data to be
available.

Note XCTU is required to generate and save configuration profiles. See How to create a profile using
XCTU for more information about generating profiles.

https://www.digi.com/products/rf
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Mesh networking
A mesh network is a topology where each node in the network is connected to other nodes around it.
Each node cooperates in the transmission of information. Mesh networking provides three important
benefits:

n Routing. With this technique, the message propagates along a path by hopping from node to
node until it reaches its final destination.

n Ad-hoc network creation. This is an automated process that creates an entire network of
nodes on the fly, without any human intervention.

n Self-healing. This process automatically determines if one or more nodes on the network is
missing and reconfigures the network to repair any broken routes.

With mesh networking, the distance between two nodes does not matter as long as there are enough
nodes in between to pass the message along. When one node wants to communicate with another,
the network automatically calculates the best path.
A mesh network is also reliable and offers redundancy. If a node can no longer operate, for example
because it has been removed from the network or because a barrier blocks its ability to communicate,
the rest of the nodes can still communicate with each other, either directly or through intermediate
nodes.

Note Mesh networks use more bandwidth for administration, and therefore have less available for
payloads. They can also be more complex to configure and debug in some instances.



Application layout

The XBee Network Assistant application is divided into five main sections:

Menu bar 13
Toolbar 13
Action bar 13
Working area 13
Status bar 15
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Menu bar
The menu bar is located at the top of the application. You can use the menu bar to access all XBee
Network Assistant features.

Toolbar
The toolbar is located below the menu bar near the top of the page. You can use the toolbar to access
the main XBee Network Assistant features.

Action bar
The action bar is located below the toolbar near the top of the page. The left pane displays
information about the XBee network (type and number of devices), while the right pane displays the
current action, Pause or Resume.

Working area
The working area is the main control of the application and is located in the center of the tool. It
displays the XBee devices in the network, provided they are discovered either in a table or in maps.

Table view
The default view displays the network devices in a table and gives you the following information:

n Role. Device type of the XBee module. Depending on the protocol (Zigbee, DigiMesh, 802.15.4),
it can be a coordinator, router or end device.

n Node ID. Node identifier of the XBee module.

n MAC address. Unique MAC address of the XBee module.

n NET address. Network address of the XBee module.

n Firmware version. Firmware version of the XBee module.

You can re-order the columns by dragging them to another location on the screen, or you can show or
hide them using the + icon located on the right side.
The XBee module you are using to access the network and is connected to your computer is denoted

with a serial port icon ( ).
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Map view
The map view allows you to place the devices where they are geographically located, either in a
dynamic map or in a custommap for indoor networks.
In addition, to the see the location of your devices, you can also inspect and analyze the connections
and link qualities between them.
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Status bar
The status bar is located at the bottom of the screen and displays the current action. When the
application is searching new updates or installing updates, the status bar also displays the status of
the process.



Inspect your network

One of the primary features of the application is to inspect an XBee network. This feature lists all the
devices connected to the network and provides general information such as address, ID, role, and so
on. You can also place the XBee devices in a map and see the connections between each node as well
as the quality of the connections.

Join a network 17
Table view 24
Map view 29
Export the current network 40
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Join a network
The first step to visualize a network is to join the network. The only requirement for joining a network
is having an XBee device attached to your computer through a USB port. This device acts as a bridge
between the computer and the XBee network so the application can obtain network information and
communicate with any device in the network. It is not necessary for the XBee device to be connected
to the network from the beginning, as the application can configure the device to connect.
Follow these steps to join a network:

1. Attach an XBee device to a USB port of your computer.

2. Click the Join button on the toolbar. A message displays indicating that you must have an XBee
device attached to your computer to inspect a network.

3. Click OK. The wizard is displayed.

Step 1 - Select the XBee device
Select the XBee device that is attached to your computer.

When your XBee device appears, select it, and click Next to access Step 2 - Select the network source.
If the wizard cannot locate any device automatically, it prompts you to provide the serial configuration
manually.
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Configure the port parameters and click Next to open the Select the network source dialog.

Step 2 - Select the network source
If your XBee device is a Zigbee or 802.15.4 (S2C), the wizard allows you to choose between using the
network where the XBee device is connected or searching for nearby networks. Otherwise, the
application automatically selects and opens the Use XBee device network option.
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Use XBee device network
This option means that the application inspects the network where the device joins.
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Select one of the following options:
n Use current network configuration. Select this option if the device has already joined a

network and is the network you want to inspect.

Note You cannot edit these parameters unless you select the following Change network
configuration option.
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n Change network configuration. Select this option if your device is not joined to a network or
you want to join to a different network. Configure the following network parameters:
l PAN ID: The unique identifier value of the network.

l Scan Channels/Channel mask/Channel: Option to change Scan channels. Complete this
option according the the protocol of your XBee device:

Protocol Setting name Description

Zigbee Scan channels Mask of the list of channels to scan. See the user guide
for your XBee device for more information.

DigiMesh
2.4

Channel Operating channel number of the network.

DigiMesh
868/900

Channel mask Mask of the list of channels to enable or disable. See
the user guide of your XBee device for more
information.

802.15.4 Channel Operating channel number of the network.

n Network requires authentication. Option indicating the network requires authentication.
Select this option, and complete the authentication parameters:
l Encryption key. Key used for encryption and decryption (that is, Zigbee trust center link

key).
o Encryption options. Numeric value based on the following configuration. Starting with a

value of 0:
o Bit0 - Acquire / Transmit network security key unencrypted during joining: +1 to the

numeric value.

o Bit1 - Use Trust Center: +2 to the numeric value.

o Bit2 - Use hash link key: +4 to the numeric value.

o Bit3 - Use Authentication (for trust center only): +8 to the numeric value.

When you are done with the configuration, click Next to join the network and open Step 3 -
Load existing network. If there are problems joining the network, an error message is
displayed.

If you do not want to load an existing network, click Finish to start inspecting the network.

Search for networks
The wizard allows you to select the network you want to join from a list of nearby networks.
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The available networks are displayed in a table with the following information for each network:
n PAN ID. Personal Area Network (PAN) ID the device should join

n Channel. Operating channel of the network.

n RSSI. Received Signal Strength Indicator of the network.

If the network you want to join requires authentication, check the Network requires authentication
option and complete the authentication parameters:

n Encryption key (KY). Key used for encryption and decryption (that is, the Zigbee trust center
link key).

n Encryption options (EO). Numeric value based on the following configuration. Starting with a
value of 0:
l Bit0 - Acquire / Transmit network security key unencrypted during joining: +1 to the

numeric value.

l Bit1 - Use Trust Center: +2 to the numeric value.

l Bit2 - Use hash link key: +4 to the numeric value.

l Bit3 - Use Authentication (for trust center only): +8 to the numeric value.
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Step 3 - Load existing network
Optionally, you can specify the wizard you want to start inspecting a network, based on networks you
have already exported. With this option, the Table and Map views are populated with the devices in
the exported file, and new devices are added as they are discovered.

Click Browse to search for the exported network file you want to load.

Note See Export the current network topic for more information about exporting networks.

Click Finish to start inspecting the network.
Once your XBee device joins a network, the application starts collecting data and displaying the
discovered devices with detailed information in both the table andmap views.

Note After a device joins a network, it maintains a running discovery process to notify you when new
devices are added or lost.
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Table view
The table view lists all the devices of the network with detailed information the application discovers
new devices.

The following columns can be displayed in the table:
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n Columns shown by default:
l Device info. Displays an icon with addtional information about the device.

Icon Description

Standard XBee device.

Indicates the XBee device attached to your computer and used to inspect the
network.

Indicates the XBee device is not reachable. It has been in the network at some
point, but now it cannot be found.

l Role. One of the following device types:

Icon Description

Coordinator

Router

End device

l Node ID. Node identifier of the XBee device.

l MAC address. Physical address of the XBee device; this is unique for each XBee device.

l NET address. Address of the device within the network (short address).

l Firmware version. Firmware version of the XBee device.
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n Other available columns:
l Hardware version. Hardware version of the XBee device.

l Elapsed. Total time (in minutes and seconds) elapsed since the update process for the
XBee device started until finished.

l Status. Status of the update process. Available statuses are:

Icon Description

Waiting. XBee device waiting for the update process to be executed.

In progress. Update process in progress.

Success. Update process finished successfully.

Error. Update process failed.

n Progress. Total percentage of the update process for the XBee device.

n Details. Information about the actions taking place in the update process. If the update
process failed, this column displays the reason.

Note You can display additional columns or hide columns by clicking the table menu button.

You can also sort the columns by dragging and dropping the corresponding column headers.

When the application detects an XBee device in the network, it displays it in the table. If the
application is unable to communicate with the XBee device, some of the properties appear empty and
are grayed out.

When the application is able to communicate with the XBee device, the properties are displayed, and
you can operate the device. For more information, see Update your network.
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Table toolbar
The network table contains a toolbar that allows you to perform the following actions.

Name Description Image

Filter button Toggle to Show only the programming devices.

Lock scroll button Toggle to Lock scroll and unlock.

Clear devices button Clear the list of devices.

Search box Search for XBee devices in the table.

Show only the programming devices
When you are performing an update network operation, you may want to display only those devices
that are being updated. Click the Show only the programming devices button on the toolbar to
display only the XBee devices that are being updated. Click the button again to display all the XBee
devices.

Lock scroll
Whenever a new XBee device is added to the table, the view automatically scrolls to the bottom of the
table. You can click the Lock scroll button on the toolbar to disable this feature andmaintain the view
at its current position. Press the Lock scroll button a second time to unlock the view.

Clear the network devices
Click the Clear the network devices button to remove the devices from the table.
This operation does not remove, or disconnect, devices from the network; it removes them from the
table. If the devices are found again while inspecting the network, they are added to the table.

Search for XBee devices
You can use the search box of the network table toolbar to find XBee devices by search prefix. Type
the search expression in the search box.
You can use the following search prefixes:
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Search prefix Colon Search by

ROLE : Device type (Coordinator, Router or End device).

ID : Node identifier of the XBee device.

MAC : MAC address of the XBee device.

NET : Network address of the XBee device.

FW : Firmware version of the XBee device.

HW : Hardware version of the XBee device (starts with '0x').

STATUS : Status of the XBee device update operation.

Note By default, if no prefix is specified, the search box filters by MAC address. To search by MAC, type
a part of the address using some wild cards.

For example: *4F* shows only the XBee devices with a MAC address that contains 4F.

You can also use a wild card if you do not want to specify the entire parameter, or if you want to find
more than one programming task.

Wildcard Equals

* any string

? any character

\ escape for literals (i.e. *, ?, or \)

The following table lists some examples of wild card usage:

Description Search box text

Get all the XBee devices whose MAC is of this range:
0013A20040F2XXXX

MAC:0013A20040F2* or
0013A20040F2*

Get all the XBee devices whose MAC is of this range:
0013A20040F213XE

MAC:0013A20040F213?E or
0013A20040F213?E

Get all the XBee devices whose firmware version is 23A7 FW:23A7

You must always include the complete MAC address in the search box or a partial MAC address with
wild cards.
For STATUS, you can also start typing a valid status value in the search box; for example, STATUS:Su
without using wild cards. Only successfully updated XBee devices will appear.

Note Blank spaces are taken into account. Be careful introducing spaces after the colon that
separates the prefix and the search expression.

'STATUS:Error' (correct).
'STATUS: Error' (incorrect) - There is a space between the colon and the expression).
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Map view
The map view allows you to locate XBee devices in a map and get information about the connections
between the different nodes of the network. This view is divided in two areas:

n XBee devices list. This list is located on the left side pane and displays all the XBee devices
contained in the network. Each device is represented by its MAC address, role (coordinator,
router, or end device) icon and node identifier.

n Map. The map is located on the right side pane, and there are two types of maps that can be
used to locate XBee devices:
l Dynamic map. Geo-locate XBee devices around the world.

l Static map. Load a map image and place XBee modules. This works well with indoor
spaces and buildings.

The first time you join a network, the map view requests the map type (dynamic or static) to locate
the XBee devices on the network. Select the appropriate device.
If your first selection was incorrect, you can switch between dynamic and static maps at any time
using the Maps navigation control.

Place devices in the map
When you have selected the map to work with, you can start placing XBee devices. Drag and drop the
device from the XBee devices list to the appropriate position in the map .

When you place the device, it appears in the map with an XBee-shapedmarker that contains the role
(that is, coordinator, router, or end device) and is labeled with its MAC address so it can be easily
identified. You can drag and drop the marker anywhere on the map.

Note If the device is not ready for communication, the marker is grayed out.
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When you select a marker, a pop-over dialog appears above it with details about the XBee device. The
following information is included for each device:

n MAC address.

n Role.

n Node identifier.

n Network address.

n Firmware version.

n Hardware version.

n Position X. For dynamic maps, this equal the longitude coordinate. For static maps, this is the
X relative position of the marker in the image (in pixels).

n Position Y. For dynamic maps, this equals the latitude coordinate. For static maps, this is the
Y relative position of the marker in the image (in pixels).
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To remove a marker, right click the marker and select Remove. You can also remove markers from
the list of devices using the same steps.

Map toolbar
The map toolbar allows you to perform some common operations that you can perform in the map
view regardless of the chosen map type (dynamic or static). The map toolbar contains the following
options:

Name Description Image

Snapshot button Take a snapshot.

Opacity control Change the map opacity.

Toggle connections Show the connection lines.

Center button Center the map view.

Clear markers button Clear the mapmarkers.

Search box Search for places on the map.
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Take a snapshot
You can take a snapshot of the currently displayedmap at any time, including the XBee markers. Click
the Snapshot button on the toolbar and specify the name of the image to save.

Change the map opacity
Depending on the map being displayed, it may be difficult to distinguish the XBee markers or their
labels. The opacity control allows you to change the opacity of the map, so markers can be seen more
clearly. Click the Opacity control icon on the toolbar and specify the desired opacity with the slider.

Show the connection lines
Apart from the devices contained in a network, the XBee Network Assistant application retrieves
information for all the connections between the listed nodes. These connections are hidden by default,
but you can show them by clicking the Toggle connections button on the toolbar.

Each line represents the connection between the two XBee devices. The color of the line changes
depending on the quality of the connection. For more information about connection quality ranges and
colors, see Map settings.
If any of the devices that are part of the connection are not ready for communication, the connection
appears as a dotted line.
Select a connection to view details. When you select a connection, it displays a pop-over dialog with
specific information about bidirectional quality and status of the connection.
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There are some protocol related considerations that you should note when checking the connections
between nodes:

Protocol Description

802.15.4 The quality of the connection between two XBee devices is not displayed. The devices are
in the RF range of the XBee device attached to the computer.

DigiMesh The quality of the connection between two XBee devices is displayed in dB.

Zigbee The link quality is represented by Link Quality Indication, or LQI, a number between 0 and
255, where 0 is the weakest and 255 is the strongest.

Center the map view
Depending on the map type, this control has different behaviors:

n Dynamic maps. Centers and zooms in or out the map until all the XBee device markers are
displayed on the map view. The view is centered and focused on the displayed devices.

n Static maps. Zooms in or out the image of the map until it fits the size of the map view. The
view displays the full map image.

Clear the map markers
To clear all the markers from the current map, click the Clear the map markers button on the
toolbar.

Search for places in the map
In dynamic maps, you can use the Search box on the tailboard to look for specific places or directions.
Type the direction you want to access and press Enter. The map automatically moves to that direction
or place.

Note This feature is disabled in static maps.

Maps navigation control
The map view includes a navigation control that allows you to change between dynamic and static
maps or add new static maps. It is located at the top left corner of the view.
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n Dynamic map

n Static map

Dynamic map
Dynamic maps allow you to geo-locate your XBee devices around the globe.
To access the dynamic map click the Dynamic option on the maps navigation control.

Dynamic map types
With Dynamic maps, there is only one dynamic map to place XBee devices. However, you can configure
the dynamic map type to display in different ways. You can use the following supported dynamic map
types:

n Terrain. Shows the terrain and vegetation.

n Roadmap. Shows the street view of a region. Default type.

n Satellite. Shows the satellite images of a region.

n Hybrid. Shows the major streets and important places on satellite images.

To configure the dynamic map type, click the arrow next to the Dynamic option of the maps
navigation control to display all the available types and select the appropriate map type.

Static map
Static maps allow you to locate your XBee devices in custom maps (images) such as interiors or
buildings. You can add an unlimited number of static maps.
To access the static maps, click the Static option of the maps navigation control.

Add a static map
To work with static maps, you need to add at least one map. You can addmore maps and navigate
between them at a later time.
To add a static map, click the arrow next to the Static option of the maps navigation control and
select the + option. The Add static map dialog is displayed.
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If you click the Static option on the maps navigation control and there are no static maps, you are
prompted with the Add static map dialog. Otherwise, the view changes to the last static map
selected.

Add static map dialog
Use the Add static map dialog to add and configure a static map.

Set the following properties of the dialog to create a new static map:
n Name. Type the name of the static map; this is the map identifier and it must be unique. There

cannot be more than one static map with the same name.

n Map layers. Each static map needs to contain at least one layer. A layer can represent a floor
or a specific section of a building.
l To add a layer, click the + button of the Map layers section, select all the images you want

to add as layers from the File selection dialog and click OK. The images you select are
added as layers and each layer is named automatically with the name of the image file.

l To remove a layer, select it and click the - button of the Map layers section.

Note Double-click the name of the layer to change the name. The label control changes to
a text box where you can enter the new name. When you are finished, press Enter to
rename the layer.
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n Include geolocation. Optionally, you can provide a geo-location to the map. Select the Include
geolocation option of the dialog, and then click the location on the dynamic map where you
want it placed.

When you are finished, click the Add map button to add the static map to the list. The view changes
automatically to the first layer of the static map you just added.
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Note If the static map was configured with geo-location, a new marker is displayed in that position
within the dynamic map. You can double-click the marker to access the static map.



Inspect your network Map view

XBee® Network Assistant User Guide 38

Static map quick menu
When you are working with static maps, the static map quick menu appears in the top-right corner of
the map view with the name of the map that is currently displayed.

Hover over the control to highlight and expand the options. You can edit or remove static maps, and
you can work with static map layers.

Edit static map
The static map quick menu allows you to edit the current map to change its name, layers, or location.
The Edit static map dialog is similar to the Add static map dialog where you can add, remove, and
configure map layers. For more information, see Add a static map.
To edit a map, click the Edit map button on the menu. The Edit static map dialog appears.
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Complete the appropriate changes, and click the Edit map button to apply the new map settings.

Remove static map
To remove a static map, click the Remove map button on the menu.

Click OK to confirm that you want to remove the map.
When you remove a static map, all the XBee device markers within it are also removed, and the map
view changes to the next static map in the list. If the map was the only static map, the view
automatically displays the dynamic map.

Work with static map layers
The layers list on the static map quick menu displays all of the layers contained in the static map. The
layer that is currently selected and displayed is highlighted in bold. From this list you can change the
current layer, reorder layers, or add layers.

Change the current layer
To display a different layer of a static map, click the layer you want to view from the list.
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Reorder layers
You can reorder the map layers from the static map quick menu. Set the mouse pointer over the move
icon ( ) for the layer, and drag the layer to the desired position in the list.

Add a new layer
To add a new layer, click the + button located at the bottom of the layers list. Select the images you
want to add as layers from the File selection dialog and click OK.

Export the current network
When all the XBee devices in your network have been located and they are placed in a map, you can
export the network to save its current state and import it in future sessions to work offline.
Complete the following steps to export an XBee network:

1. Click the Export button on the toolbar. The Export network dialog appears.

2. Type the name of the network and a brief description.

3. Click Export and select the destination file for the network.



Update your network

The XBee Network Assistant application allows you to configure and update single or multiple XBee
devices on your network simultaneously. You can change the settings of your modules, update the
firmware, or both.
The update process is based on configuration profiles. A configuration profile is a snapshot of a specific
radio firmware configuration that contains information about the radio firmware, its settings, and
other metadata.

Note To learn more about configuration profiles and how to create them, see the Configuration profile
topic.

Once you have discovered your network and created a configuration profile, complete the following
steps to begin the update process:

1. Click the Update button on the toolbar. If there is a network scan in progress, the scan
automatically pauses. A dialog appears with information about the configuration profiles.

2. Click OK to continue. You can optionally select the Do not show again check box if you do not
want this dialog to appear again. The Add configuration profile wizard appears.

3. Using this wizard, select the configuration profile and the XBee devices you want to update
with this profile.

n Select the profile

n Select the target devices

n Addmore profiles

n Start the update

Udate network considerations
Normal network updates only require some minor changes to improve remote node performance; for
example, updating some IOs. However, there may be times when you need to change the parameters
that define your network, such as the Pan ID. Errors in changing these parameters may cause part of
the network to become unreachable.
For this reason, the XBee Network Assistant application uses a secure configuration algorithm
whenever any of these network parameters need to be updated. The goal of this algorithm is for the
network to remain in a consistent state and be reachable.
The algorithm works as follows:

1. Verify the list of profiles to configure the network, and check if any of the network parameters
need to be applied. The list of network parameters includes:
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n ID: Pan ID

n HP: Preamble ID

n CH: Channel number

n SC: Scan Channels

n CM: Channel mask

n EE: Encryption enable

n KY: Encryption Key

n EO: Encryption options

2. If the algorithm is needed, the tool verifies that all of the nodes will update the required
network settings. If all devices are not selected, a dialog appears indicating that the network
could remain inconsistent and asks you if you want to continue.

3. To verify that the network remains reliable, the update process starts from the farthest to the
closest nodes in the network, and finishes on the local device.

Select the profile
To select the profile, load the desired configuration profile to configure the network.
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1. Click Browse....

2. Locate and select the configuration profile you want to use.

3. Click Next >.

Select the target devices
After you have loaded the configuration profile, select the XBee devices from the network to which
this profile applies. You may want to update all the XBee devices; for example, if you are upgrading the
firmware or changing some settings. Other times, you may only want to configure specific groups or
single devices; for example, if the routers have a different configuration than the end devices.
This step allows you to select which targets to apply targets to the profile:

n All. The profile applies to all the XBee devices of the network.

n Specific groups. The profile applies to the selected groups: coordinator, routers, or end
devices. You can include multiple groups.

n Specific devices. The profile applies to the selected devices on the list.

When you have selected the devices you want to update with the profile, click Finish.
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Add more profiles
To start the update process, you need at least one profile, but you can addmore. This is useful if the
configuration you want to apply is different between modules. For example, if you have different types
of XBee modules in your network, the firwmare may not be the same in all of them. In this case, you
can create a different profile for each type of XBee device.
To add a new profile, click the + button; the Add configuration profile wizard appears. If you want to
remove a profile from the list, select it and click the - button.

Start the update
Once you have added the profiles to update your network, click Start to begin the process.
Before starting the update, you may see a progress dialog. This means the application is verifying the
configuration profiles and establishing the order of the update.
The tool displays the following columns in the table:

n Elapsed. Total elapsed time of the update process in minutes and seconds from beginning to
end.
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n Status. Status of the update process. The statuses are as follows:

Icon Description

Waiting. XBee device waiting for the update process to be executed.

In progress. Update process in progress.

Success. Update process finished successfully.

Error. Update process failed.

n Progress. Total percentage of the update process.

n Details. Information about the actions taking place in the update process. If it fails, this field
displays the reason.

Note When network parameters change, the order of the update is not sequential from the first XBee
device to the last one in the table. The application calculates the routes and connections between the
devices, and, based on this calculation, updates them from the furthest to the nearest devices.
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When all the devices you selected have been updated, the application displays a dialog with the
summary of the process. You can continue the network scan or close it.



Work offline with your network

The XBee Network Assistant application is designed to work with live XBee networks. However, there
is some functionality that can be used without having an XBee device connected to your computer or
access to the network.
To work offline with the application, you must import an XBee network that was previously exported
(see Export the current network for more information).

n Import an XBee network

n Available features while working offline

Import an XBee network
To import an XBee network, complete the following steps:

1. Click the Import button from the toolbar. A dialog appears for you to select the XBee network
file (.xnet).

2. Select your network and click Open.
The application adds the XBee devices that form the network to the table; this includes the exported
maps and the locations of the devices. By default, all the XBee devices appear disabled and grayed
out, unless you still have the XBee device that you used to access the network connected to the
computer.
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Available features while working offline
When you import an XBee network, you only see a snapshot of how the network appeared when it
was exported. This means the network you have importedmay not be completely accurate, because it
may have been altered since it was exported.
For this reason, the functionality of the application is limited to the following tasks when working
offline.

Resume the network scan
When you import a network, you can resume the scan by clicking the Resume button from the action
bar if you still have access to the network. This is useful if you want to compare the status of the
network when you exported it versus the online version.
If the XBee device you exported is still connected to the computer, the application resumes the scan
automatically. Otherwise, it prompts you to select a new XBee device that is connected to your
computer. If network devices are discovered, they appear available in the table andmap views.

Update some devices
Because you are working offline, you can only update XBee devices that are connected to your
computer (if any). However, if you resume the network scan and the devices become available, you
can update them as well.
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Work with the maps
You can visualize the XBee devices on the network in the table view and in the maps. In addition, you
can change the device locations, analyze device connections, and add, edit or remove any static map.

Export the network
Use this feature if you made any modification in the device locations or in the maps and you want to
preserve those changes. The export process is the same as if you were working online with the
application.



Applications settings

This section provides information on how to configure multiple XBee Network Assistant settings. To
open the Settings dialog, click the Settings button on the toolbar or select the File > Settings.

The setting categories are listed on the left side of the Settings dialog. You can configure settings for
the following categories:

Map settings 51
Network settings 51
Update settings 53
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Map settings
To configure settings related to the maps, complete the following steps:

1. Click the Settings button on the toolbar or select File > Settings from the menu. The Settings
dialog appears.

2. On the left side of the Settings dialog, select Map.

3. Configure the appropriate settings and click Apply.

Network settings
To configure settings related to XBee networks, complete the following steps:

1. Click the Settings button of the toolbar or select File > Settings from the menu. The Settings
dialog appears.
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2. On the left side of the Settings dialog, select Storage.

3. Configure the appropriate settings and click Apply.

Setting Description

Remove nodes
that are not
reachable

Enables or disables the removal of XBee devices that are not reachable on the
network. A node is not reachable if it was part of the network but can not be
discovered anymore.
If you select this setting, the unreachable devices are removed from the table
andmap; otherwise, the application shows a warning icon for those devices.

Time between
scans

Specifies the time to wait before starting a new scan during the constant
network scan process. The value must be between 0 and 300 seconds (5
minutes).

The remainder of the options are specific to 802.15.4, DigiMesh, and Zigbee network types:



Applications settings Update settings

XBee® Network Assistant User Guide 53

Setting Description

Discovery
mode

Sets the method used by the network discovery process.
n Flood: The neighbor discovery process is performed for every node at the

moment the node is found. Several discovery processes may be running at the
same time. This methodmay be faster, but it may also generate high traffic and
saturate the network.

n Cascade: The neighbor discovery process is performed for every node as soon as
the discovery process completes. Only one discovery process runs at a time. This
methodmay be slower, but it is likely to generate less traffic. This method is the
most reliable.

Neighbor
discovery
timeout

Sets the maximum duration, in seconds, the discovery process should spend finding
neighbors of a module. The values must be between 5 and 1800 seconds (30 minutes).
This timeout is highly dependent on the nature of the network. For DigiMesh, the value
should be greater than the highest NT (Node Discover Timeout) and include enough time
to let the message propagate, depending on the sleep cycle of your devices.

Time
between
requests

Sets the wait time between node neighbor requests. The value must be between 0 and
300 seconds (5 minutes).
For the Cascade method, this is the number of seconds to wait after completion of the
neighbor discovery process of the previous node.
For the Floodmethod, this is the minimum time to wait between each radio module's
neighbor requests.

Update settings
You can configure the application to automatically check for new application updates when the
application starts.

1. Click the Settings button of the toolbar or select File > Settings from the menu. The Settings
dialog appears.
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2. On the left side of the Settings dialog, select Update.

3. Select or clear the Automatically check for updates every time the application is started
checkbox to enable or disable the automatic updates feature.

4. Click Apply.



Update the tool

The XBee Network Assistant allows you to automatically update the application without downloading
any extra files. This process can be configured to execute automatically, but you can also execute it
manually at any time. For more information about configuring automatic updates, see Update
settings.
If you have enabled the automatic updates, you may be notified about software updates when you
open the XBee Network Assistant. You should always run the latest version of the tool.

1. When a new version is available, a notification window appears asking you if you want to
update the application.

2. Click Yes to start the update process.

3. When the installation process is complete, you must restart XBee Network Assistant for new
changes to be applied. When prompted, click Yes to restart the tool.

You can also check for updates andmanually update the tool by clicking Help > Check for updates.

Note Click the Run in background button of the progress dialog to execute this process in the
background. The status bar displays the update progress.
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How-to articles

The following pages contain how-to articles describing some of the most common procedures to work
with the XBee Network Assistant tool.

How to create a profile using XCTU
XCTU is required to generate and save configuration profiles. This section provides the steps to create
a profile using XCTU.
For more information about configuration profiles, see Configuration profile.

Step 1: Configure the profile
XCTU offers two methods for configuring a profile:

n Configuration working mode

n Firmware explorer

Configuration working mode
Configuration working mode allows you to quickly generate profiles for modules attached to your
computer.

1. In the main window of XCTU, switch to Configuration working mode .

2. Select a radio module from the device list.

3. Configure the radio module with the appropriate values. You only need to change the values;
they don't need to be written to the specific module.

4. Click the Configuration profiles drop-downmenu on the configuration toolbar and select
Save configuration profile.

Firmware Explorer
The Firmware Explorer is useful for generating profiles for modules that you may not have.
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1. In the main window of XCTU, select the Firmware explorer tool in the tools menu.

2. Create a representative model upon which to base the configuration profile by selecting the
specific firmware (that is, Product family, Function set and Firmware version) andmodifying
the appropriate settings.

3. Click the Configuration profiles drop-downmenu on the configuration toolbar and select
Save configuration profile.

Step 2: Set the profile preferences
1. Select Save configuration profile. A window appears that allows you to set some extra

configurations:
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You can use this window to:

n Include a short description of the profile to be generated (optional).

n Select the Radio firmware flash action from the drop-down list:

n Flash always: The firmware image is always programmed into the
module. Then, if there are non-default settings, they are applied
and written to the XBee, as well.

n Flash if firmware is different: If the target device has the same
firmware version as the one selected in the profile, only the
settings are written to that device. If the target device does not
have the same firmware version as the one selected in the profile,
both the firmware and the settings are flashed into the module.

n Do not flash firmware: Only the non-default settings are written
to the device.

n Select whether you want to reset the XBee module settings to their default
values prior to applying the profile settings.

Note A profile should only be configured in compatible modules. For example, do not configure a
profile for an S2C module in an SX.
This is particularly important with the Do not flash firmware option. It should only be used when the
firmware version of the target device matches that of the profile.

2. Once you are finished, click OK in the Profile configuration window. A Save file dialog box
appears.

3. Choose a name and path and click Save.



Known issues

The XBee Network Assistant application currently has the following known issues and limitations.
The XBee device must follow these requirements to access the network:

n The device must operate in API or API escape mode. If you attempt to add a device configured
in transparent mode (AT), the application displays an error message but allows you to change
the mode.

n The device must not be an end device. The discovery process is not supported for this type of
device.

n The device must not be a coordinator if you are working with Zigbee networks. Management of
routes and connections is limited with this device type.
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